Operation Manual

Software

FanTestic

(Duct Testing)
Table of Contents

1 Getting Started .................................................................6

1.1 Video training..................................................................................6
1.2 Minimum system requirements ............................................................ 7
1.3 Download and install FanTestic .......................................................... 7
1.4 DM-2 users install a USB Driver manually........................................... 8
1.5 Start FanTestic................................................................................... 9
1.6 Select a test standard to use for new tests........................................... 10
1.7 Enter license key when you receive one............................................. 11
1.8 Change language to use for user interface and reports ......................... 12
1.9 Change parameters used for running the program – (advanced operation) .................................................. 13
   1.9.1 Basics tab for items applying to all tests........................................ 14
   1.9.2 Settings tab for items specific to each test Standard ......................... 15
   1.9.3 Application tab for items specific to FanTestic behind the scenes .... 15
1.10 Automatic Save ............................................................................. 16
1.11 Create a new Test file ..................................................................... 16

2 Enter Equipment (fans and gauges) used for the Test..........................18

2.1 Gauge Info ................................................................................... 18
2.2 Device connected to Gauge Info ....................................................... 19
   2.2.1 Calibrated Fan model ................................................................... 19
   2.2.2 Use Gauge Only – with no calibrated fan attached ....................... 19
   2.2.3 Fan Serial Number (S/N): ......................................................... 20
2.2.4 Device Location ........................................................................................................ 20
2.3 Find gauges attached to computer, automatically .................................................... 20
2.4 Changing Range in the test, manual entry ............................................................... 21
2.5 Adding multiple fan/gauge pairs ............................................................................. 21
2.6 Retrieve Gauge serial number and fan model automatically .................................. 21
2.7 Delete a Fan/Gauge pair ....................................................................................... 21
2.8 Test Technician and report identifier .................................................................... 22

3 Enter Building and Duct Network information ....................................................... 22
3.1 Building Address ..................................................................................................... 22
3.2 Type of Building ..................................................................................................... 22
3.3 Customer details ................................................................................................... 23
3.4 Witness .................................................................................................................. 23
3.5 Elevation (above sea level) ................................................................................... 23
3.6 Duct System Installer ......................................................................................... 23
3.7 Duct System manufacturer .................................................................................. 23

4 Enter Duct Network information for this test ....................................................... 23
4.1 Duct Information for EN12237 and FD E-767 ....................................................... 23
4.1.1 Class of duct network ..................................................................................... 23
4.1.2 Temperature ...................................................................................................... 23
4.1.3 Operating pressure in ducts ............................................................................ 24
4.2 Information for DW/143 ....................................................................................... 24
4.2.1 DW/143 Duct Class ....................................................................................... 24
4.2.2 Temperature ...................................................................................................... 24
4.2.3 Operating pressure in ducts ............................................................................ 24
4.3 Information for SMACNA ..................................................................................... 24
4.3.1 SMACNA Duct construction Class ................................................................. 25
4.3.2 SMACNA Duct sealing Class ......................................................................... 25
4.3.3 Temperature ...................................................................................................... 25
4.3.4 Specified test pressure ................................................................................... 25
4.4 Information for single point Residential test (North America) ............................. 26
4.4.1 Floor area ......................................................................................................... 26
4.4.2 Temperature ...................................................................................................... 26
4.4.3 Operating pressure in ducts ............................................................................ 26

5 Manage Pressurization/Depressurization (Data) Sets ......................................... 26
5.1 Adding a Set to the Test ....................................................................................... 29
5.2 Removing a Set from the Test ............................................................................... 29
5.3 Clearing Data in the Set ........................................................................................ 29
5.4 View Graph of data in the Data set ...................................................................... 29

6 Enter Test Data ......................................................................................................... 30
6.1 Start date ............................................................................................................... 31
6.2 Start Time ............................................................................................................... 31
6.3 Operator location .................................................................................................. 31
6.4 Duct Surface Area ............................................................................................... 31
6.4.1 Duct Area Entry - EN12237 and FD E51-767 ................................................... 31
6.4.2 Duct Area Entry – DW/143 ............................................................................ 31
6.4.3 Duct Area and Leakage Factor Entry – SMACNA ......................................... 32
6.5 Pressure in the ducts data line.................................................................32
6.6 Test Fan Data lines.................................................................................32
  6.6.1 Select Range installed on fan during test...........................................32
  6.6.2 Enter Fan Pressure value:.....................................................................34
  6.6.3 Manual range change – how to add another fan pressure line............34
  6.6.4 When to change range during a test.....................................................35
6.7 Results for the Set .....................................................................................35
  6.7.1 Allowed flow calculated before test commences.................................35
  6.7.2 Duct leakage flow results for the Set ..................................................36
  6.7.3 Calculated results – EN12237 ...............................................................37
  6.7.4 Calculated results – FD E51-767 .........................................................37
  6.7.5 Calculated results DW/143 .................................................................38
  6.7.6 Calculated results - SMACNA ..............................................................38
  6.7.7 Calculated results - single point residential (North America) .............41
6.8 Data set notes .........................................................................................41
6.9 Finish time ..............................................................................................41

7  Capture data with a Semi-Automatic Test .................................................41
  7.1 Before performing the semi-automatic test .............................................41
  7.2 Connect your Gauge to the Computer ....................................................42
    7.2.1 DM-2 (use USB connection) ..............................................................42
    7.2.2 DM32 with WiFi connection ............................................................43
    7.2.3 DM32 with Wired Ethernet connection ..........................................43
  7.3 Find connected gauges to use for the test ..............................................44
  7.4 Understanding the Semi-Automatic Test Mode ......................................44
  7.5 How to use the Semi-Automatic Test feature .......................................44
  7.6 Changing the Range during a semi-automatic test ...............................46
  7.7 View the Gauge Display during a semi-automatic Test ..........................48

8  Summary Test Results .................................................................................49
  8.1 Compliance – was test performed according to Standard? ....................49
    8.1.1 Compliance – EN12237 and FD E51-767 ........................................49
    8.1.2 Compliance DW/143 ........................................................................50
    8.1.3 Compliance – SMACNA ....................................................................51
    8.1.4 Compliance – single point residential (North America) .................52
  8.2 Summary Results – average of test data sets .........................................53
    8.2.1 Single point residential Summary Results .......................................53
    8.2.2 DW/143 Summary Results ...............................................................53
    8.2.3 SMACNA Summary Results ..............................................................54
  8.3 View Graph of Summary Results ............................................................54

9  Cost of Duct Leakage calculator ...............................................................55
  9.1 Percent Duct Leakage to Outdoors .........................................................56
  9.2 Air Handler Flow ....................................................................................56
  9.3 Annual Cost of Heating ........................................................................56
  9.4 Annual Cost of Cooling .........................................................................56
  9.5 Rated SEER for cooling equipment .........................................................56
  9.6 Leakage Split (Supply and Return) ........................................................56
  9.7 Supply Leakage Penalty .........................................................................56
  9.8 Return Leakage Penalty .........................................................................56
9.9 HVAC System Efficiency Loss
9.10 Cost of Heating the Leakage
9.11 Cost of Cooling the Leakage
9.12 Annual Operating SEER

10 Use the Test results
10.1 Open an existing Test file
10.2 Save results to a test file (.exml)
10.3 Save As to save results to a different file
10.4 Print the Test as a Print-Screen

11 Create a report from the Test results in MS Word
11.1 Generate Report
11.2 View listing of reports
11.3 Customize the way your Report looks

12 Export Data to MS Excel

13 Troubleshooting

14 Contact Tech Support
14.1 The log file
14.2 The .exml test file
14.3 Settings file
14.4 A screenshot

Copyright © 2017 Retrotec,
All rights reserved.

This document contains materials protected under International and Federal Copyright Laws. No part of this book may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, or by any information storage and retrieval system without express written permission from Retrotec.

Retrotec makes no warranties with respect to this documentation and disclaims any implied warranties of merchantability, quality, or fitness for any particular purpose. The information in this document is subject to change without notice. Retrotec reserves the right to make revisions to this publication without obligation to notify any person or entity of any such changes.

FanTestic is a Trademark of Retrotec. Other trademarks or brand names mentioned herein are trademarks or registered trademarks of their respective owners.
1 Getting Started

FanTestic is software designed to capture data and calculate results required for the analysis of building or duct air leakage based on one of a number of published Test Standards.

You can carry out the building leakage tests using a gauge, fan and door panel and capture the readings on paper to later enter into FanTestic so the software can calculate compliance for you and generate a report in MS Word or put your test readings into MS Excel. This is called a Manual Test in this document.

Alternatively, you can use FanTestic to automatically control your gauge and fan to carry out the test by stepping through the required induced pressure target points and capturing data according to the Test Standard, again with the ability to generate a report or Excel data. This is called an Automatic Test in this document.

A Semi-Automatic mode is also included if you need more control of your test at each induced pressure target point.

Be sure you are familiar with carrying out an air leakage test before attempting to use the software – for reference you can look at the following Retrotec guides:

- DucTester Operation Manual (for model 341)
- DucTester 200 Series Manual for Residential Applications
- Commercial DucTester Operation Manual (for Model 400 series)
- Air Leakage Testing Procedures Manual

For blower door applications:

- Door Fan Operation Manual: for 200, 300, 1000-3000 systems for 300, 5000-6000 systems
- Multiple Fan Testing (Large Buildings): for 1000-3000 systems for 5000-6000 systems

1.1 Video training

The following videos explain the steps to be taken:

- Webinar with SMACNA testing shown in FanTestic
- Webinar showing FanTestic Operation

The following videos are for older versions of the software but you may find them valuable in general, since many of the steps required to use the software have remained the same.

- Webinar for FanTestic Operation including demo of Virtual Gauge software for DM32
- How to enter data from a Manual Test (ASTM)
How to use FanTestic to capture data automatically (ASTM)

Graphing and Saving Test Data

For more Retrotec videos and webinars on other topics, visit http://www.youtube.com/user/RetrotecEnergy

1.2 Minimum system requirements

- Microsoft Windows O/S: XP (SP2 or greater) or newer (Vista/7/8) – current with all updates
- Processor: 1 GHz
- RAM: 1 GB
- Disk space: 600MB (32-bit) or 1.5 GB (64-bit)
- Internet connection (for automatic software updates)
- .NET 4.0 framework (will update automatically with the FanTestic installation)

1.3 Download and install FanTestic

a) Go to: http://retrotec.com/support/software-downloads
b) When the webpage opens, click on the “Download” button beside “FanTestic (Lite/Pro/6/24)”

c) Click the “Install” button on the window that opens.
d) When prompted with “Do you want to run or save setup.exe?” click on the “Run” button.

e) If not prompted, go to the Downloads menu option on your web browser and double-click on the file you have just downloaded (which is called “setup.exe”).

f) The “Application Install – Security Warning” window will open:

g) click on the “Install” button.

h) If the User Account Control (UAC) asks for permission, you must give administrator permission for the software to install the DM32 USB driver automatically.

i)

j) The program will install, and try to start FanTestic for you.

k) If you have been running a previous version of FanTestic and have been using “Run As Administrator” mode, you will receive the following non-fatal message indicating that the installer cannot launch the software because FanTestic must run in Administrator mode:

l) Just click ok and launch FanTestic as described in section 1.5.

1.4 DM-2 users install a USB Driver manually

If you want to run automatic tests with a DM-2 gauge, you must download and manually install a driver for the USB port.

DM32 users will have the driver automatically installed when they install FanTestic or the DM32 Software Suite, and should only use USB connection to update the firmware through the DM32 Configurator, not for automatic control of the gauge.

DM32 users should use Ethernet to connect to the gauges for auto-testing, since that will provide the longest cable option and most reliability. WiFi can also be used depending on the distance between the gauge and the computer and the type of building construction.
a) Go to: http://retrotec.com/support/software-downloads

b) Download by clicking on the “Download button and when prompted to Run or Save, choose “Save”

c) To install the Retrotec DM2 driver (DM2deviceinstaller32.exe or DM2DeviceInstaller64.exe), do not double click the file when the download has completed. Instead, right click the downloaded “DM2deviceinstaller” file, and select Run as administrator to start the installation. This will give permission to install the required system files.

1.5 Start FanTestic

After installation, click the Start Menu → All Programs → Retrotec → FanTestic.

OR use the icon on your desktop to start the program. FanTestic will open!

FanTestic will run in demo mode with full functionality for 30 days after you first install. Once the demo version expires, you will not be able to change the test standard being used for new tests, generate the MS Word reports or export your test data to MS Excel. You will still be able to enter test data and see the results on-screen, and open tests generated using any of the test standards.
Obtain a license and instructions for activating the software with the license before your demo expires by contacting sales@retrotec.com. The license will be valid for the period of time specified for the license, and with a valid license you will be able to generate the MS Word reports and export your test data to MS Excel.

If your demo or license has expired you will see a dialog window similar to the following when you start FanTestic:

![Dialog window for expired demo]

Click “OK” to start the limited version.

The main FanTestic menu bar is at the top, to provide access to functions needed pre and post test.

The first time you run FanTestic, you need to make some choices about how you will use FanTestic—access from the “Settings” menu as described in the next sections.

1.6 Select a test standard to use for new tests

FanTestic is based on national and international standards which specify how the Duct Leakage Tests are to be performed in order to be valid. Choices of test standard are available “Settings” → “Change Standard used for new tests”. The number of Test standards available to be chosen in the list depends on the license purchased.

![Settings menu]

The dialog opens for you to choose the standard by clicking on the button beside the name of the standard:
1.7 Enter license key when you receive one

- Start FanTestic, if not already running.
- Once in the program click “Settings” → “Enter license details”.

- Click on the “Install License Key” button in the dialog window that opens, and a text entry area opens:

- Copy the license key from the email you received and paste it into the text entry area that appeared, being sure to include the “===START_KEY===” and “===END_KEY===” portion of the key. If selecting from an email, be sure that the email has not inserted any odd items into the
string, such as an “emailto” link. The email containing the key that is sent out from Retrotec will be a “Text only” email, not HTML based, in order to try to minimize license corruption.

- Click on the “Install License” button below the text box.

- Test Standard may be automatically selected based on the license- if not, choose one from the list.

- Next, fill in the user’s name and email address (corresponds to the technician doing tests with the software). “Software user’s company” will be filled in automatically from the license that was entered:

- Then click “OK”.

1.8 Change language to use for user interface and reports

Start FanTestic if it is not already running.

Click on “Settings” → “Advanced - view or change default program parameters”
The Settings dialog will open, and the “Language to use” drop-down is at the bottom:

Choose the language from the language drop-down:

1.9 Change parameters used for running the program – (advanced operation)

Changes can be made any time, but a new test file must be opened for any changes to take effect. If changes are made to settings, FanTestic will save and close any open test file (user can skip this) and create and open a new Test file.

Start FanTestic if it is not already running.

Click on “Settings” → “Advanced - view or change default program parameters”
1.9.1 Basics tab for items applying to all tests

Start FanTestic if it is not already running.

Click on “Settings” → “Advanced - view or change default program parameters”

Click on “Basics” tab

![Advanced - view or change default program parameters](image)

#### 1.9.1.1 Cover fans before taking bias readings?
Selecting “Yes” will cause the software to stop after the initial bias pressure readings have been taken in order for the user to uncover the fan(s). Select “No” for a nonstop test in which test pressure will be taken immediately following initial bias pressure readings.

#### 1.9.1.2 Show calculation warning?

Show calculation warnings?  [Yes] [No]

Warnings will appear when the “Calculate” button is clicked if insufficient building information is provided (i.e. no building volume was entered, therefore ACH50 cannot be calculated). Choose Yes to view the calculation warnings.

#### 1.9.1.3 Data to show On Graphs

[Include all readings] [Show averaged points only]

This selection allows you to choose whether the graphs will show all readings, or only show the single point that is the average of all readings at any particular Test Fan pressure.

#### 1.9.1.4 Individual Control

Gauge Control:  [Common] [Individual]

The Gauge Control function allows a user choose the method that the FanTestic will use to seek a target pressure when multiple fans are being used. The Gauge Control function sets whether a number of fans are controlled with the same signal (from one primary gauge) so all fans run at the same speed or whether each fan is controlled individually and will run at different speeds.

With Gauge Control set to “Common”, all fans will be controlled by the induced pressure reading on the primary gauge, and the non-primary gauges will be set to the speed of the primary fan.

With Gauge Control set to “Individual”, each fan is controlled by the induced pressure on its own gauge. Controlling this way may result in “dueling” fans, where one takes over and runs up to a speed of 100%, while the other fans decrease to 0% speed. If this happens during your test, change to Common Control.

Each gauge must be connected to FanTestic for automatic control, and each gauge must be connected using the yellow speed control cable to its own fan. For details about setting up multiple fan tests, see
the manuals for Multiple Fan Testing (Large Buildings):  for 1000-3000 systems  for 5000-6000 systems.

**Gauge Control: “Common”**

To control the speed of multiple fans based on the speed of the primary gauge, choose “Common”. When attempting to create a pressure, FanTestic will set the target pressure on a single (primary) gauge. FanTestic tells the primary gauge to seek that target pressure, and then reads the %speed from the primary gauge, and tells all other gauges to go to that speed. This effectively turns all fans into one big fan that is controlled by the induced pressure on channel A of the primary gauge.

The first gauge in the list in the Equipment tab is the “primary gauge”. The primary gauge can be switched by the user.

**Gauge Control: “Individual”**

For each fan to be controlled only by their own gauge, choose “Individual”. When attempting to create a pressure, FanTestic will set the target pressure or speed on each of the gauges. FanTestic tells each gauge to seek that pressure target simultaneously. This would be the same as a human operator using the Set Pressure function on each gauge individually.

### 1.9.2 Settings tab for items specific to each test Standard

Start FanTestic if it is not already running.

Click on “Settings” → “Advanced - view or change default program parameters”

Click on “Settings” tab.

![Advanced - view or change default program parameters](image)

Many of the settings can be changed to accommodate user-defined testing procedures.

However, you usually want to run a test according to the default protocol rules. If so, click the **Reset to Standard Defaults** button to run a test according to the default protocol rules.

### 1.9.3 Application tab for items specific to FanTestic behind the scenes

Start FanTestic if it is not already running.
Click on “Settings” → “Advanced - view or change default program parameters”

Click on “Application” tab

1.10 Automatic Save

Test data can be automatically saved at periodic intervals by turning the Auto Save function on (“File” → “Auto save?”).

Test files are normally saved on your local C: drive under [MyDocuments]\Retrotec\Tests.

If you change the location of the test file to a remote drive, and then remove the remote drive with FanTestic running and AutoSave on, the software will not be able to save the file to the remote drive anymore, and may report an error.

Turn AutoSave Off if you wish to double click to launch test files attached to emails. If you double click on a file with extension .exml attached to an email in MS Outlook with AutoSave on, FanTestic will start up and open the test file, but when AutoSave tries to save to the inaccessible MS Outlook temporary location, FanTestic may report an error.

1.11 Create a new Test file

To create a new test, click on “New test” at the top of the history list, or go to “File” → “New”.
Make sure “New Test” on the history list is followed by the name of the Duct Testing Standard you are going to carry out. If not, go to “Settings” → “Change Standard used for new tests” and change the test standard. You may need to restart the program if this change is not active immediately.

Old tests are listed as a history, below the “New test” option, if you have the history list open. You can click on any test name or picture to open that previously saved Test. Older tests are at the bottom of the list. To open the Test History panel if you do not see it, use the menu item called “Test History” and choose “Show”.

©2017 Retrotec
2 Enter Equipment (fans and gauges) used for the Test

Each gauge/fan pair is managed by the software. Choose a Gauge model and enter the serial number. Then choose a fan model from the drop-down. You can also enter a serial number for the fan. These values are all output to the generated report.

When you enter the serial numbers, ensure that the correct gauge is paired with the fan in use. The software calculates flows from the fan pressures reported by a gauge based on the specific parameters of each fan model.

Information entered for the test technician, fan model, gauge model, and serial number will be saved and entered automatically for you when you create a new test.

2.1 Gauge Info

You must select the gauge model.

The serial number of Retrotec gauges can be found on a label on the device. The serial number can be entered manually.

You can use the “Find Gauges” button to have FanTestic find any and all gauges attached to the computer via USB (for DM-2) or via USB, Wired Network, or WiFi for the DM32. FanTestic cannot automatically detect gauges from other manufacturers.

Note that the “Find Gauges” button will read the type of fan in use from the device that is currently set on the associated gauge, and will find the gauge serial number and type. It cannot find the serial number of the fan.
2.2 Device connected to Gauge Info

2.2.1 Calibrated Fan model
Select the model of the series of fan used in your system using the pictures in the device drop-down box as a guide. Be sure to enter a Duct Testing fan, conveniently grouped together and shown in the picture with attached flex duct.

![Calibrated Fan models](image)

When you enter fan pressure values into the Test data set, you must have selected the device being used in order for FanTestic to correctly compute flow results. FanTestic uses the latest values of the Fan Flow Coefficients for each fan model to give you the most accurate value for flow.

You can, if you are entering a Test manually, directly enter flow values from the gauge but this is not recommended, as your gauge may have fan flow coefficients that are not up to date.

Note that Automatic testing will read the type of fan in use from the device that is currently set on the associated gauge.

2.2.2 Use Gauge Only – with no calibrated fan attached
In some cases, users may wish to monitor pressures during a test using gauges with “No fan” connected to the gauge.

In this case, users choose the Device called “Gauge Only” in the Device models dropdown. The Range in the Fan Pressure Line for this gauge/fan pair automatically shows up as “No fan”.

The pressure values on Channel A from the “Gauge Only” device are included in the room pressure. The pressure values read on Channel B and shown in the “No fan” line are not included in the flow calculations.

Note that Automatic testing will ignore the device that is currently set on the associated gauge if you have chosen “Gauge Only” for this gauge in FanTestic.

2.2.3 Fan Serial Number (S/N):
The serial number of Retrotec door fans can be found on a gray label at the top or side of the fan.

The serial number of the fan must be entered manually, and will be automatically read in from a previously open test when you have entered it for a previous test. Fan serial numbers and locations are included in generated reports.

2.2.4 Device Location
The Location data entry box allows you to enter details about the device, such as the location:

Location third floor west door

Fan serial numbers and locations are included in generated reports.

2.3 Find gauges attached to computer, automatically
If you have gauges connected to the computer via USB (or Ethernet if you are using a DM32), you can read the gauge serial number and the fan model that is set on the gauge, as well as the range that is set on the gauge.

To retrieve the gauge serial number and fan model automatically, click the button. If the “Find Gauges” button is not visible in the Equipment tab, that means there is data already collected in this test, and you cannot change the devices or fan numbers that were used before.

FanTestic will set the Fan model in the Equipment Tab to whatever device is set on the gauge. Thus you need to ensure that the fan/gauge pair is what you expect after a Find Gauges scan.

FanTestic will add a fan pressure line in the data sets with an Open Range for each fan. See section 6.6 for details about Fan Pressure Lines.
2.4 Changing Range in the test, manual entry

The Range setting for each fan is entered in each Data Set, rather than here in the Equipment tab, because the fan can use any of its ranges at any time during the test. See section 6.6 for details.

2.5 Adding multiple fan/gauge pairs

If you have a non-expired demo or Pro license, you will be able to add more than one fan/gauge pair, and enter or collect data for both.

If you are using more than one fan, click the button as many times as the number of fans you would like to add (total number limited by the license in use).

Once new fans are added, you are given the option to note the Location - where the fan is set up in the building- for your own information and to see on the Data set graph.

The first gauge in the list is used as the “Primary gauge” when running a multiple fan test (see section 1.9.1.4 for an explanation).

Click the button to make the gauge on that line the primary gauge (placing it as #1 Fan).

2.6 Retrieve Gauge serial number and fan model automatically

If you have gauges connected to the computer, you can read the gauge serial number and the fan model that is set on the gauge.

To retrieve the gauge serial number and fan model automatically, click the button.

Note that you need to ensure that the fan/gauge pair is still correct after a Find Gauges scan – FanTestic will set the Fan model in the Equipment Tab to whatever model is set on the gauge.

2.7 Delete a Fan/Gauge pair

You can delete the line corresponding to a fan/gauge pair if it is not being used in the Test, but it is not necessary. If a fan/gauge pair line exists, a corresponding fan pressure line will appear in the Data Set.

Click the button to delete the line corresponding to a fan/gauge pair.

You must always have at least one fan/gauge pair.
2.8 Test Technician and report identifier

Enter the name of the person doing the test. More than one name can be entered in this text entry area.

If you have a unique reference number for the report on this property, enter it here.

3 Enter Building and Duct Network information

Fill out details about the building address, type, as well as the system installer and manufacturer. Building elevation information is also entered here.

3.1 Building Address

Enter the street address where the building is located. Ignore any boxes that are not applicable to your situation.

3.2 Type of Building

Choose from the list the type of the building under test. Some standards require this to set the required test pressure. Choices are Residential, Multi-family, or Commercial.
3.3 Customer details
Enter the name of the customer. If the customer is located at a different address than the building being tested, that can be entered here as well.

3.4 Witness
Some standards require entry of the name of a third party witness to the test. Enter the name and address of the witness to the test if your standard requires this.

3.5 Elevation (above sea level)
Enter the building’s elevation above sea level. This value is used to perform a small correction to the air flow rate.

3.6 Duct System Installer
Enter the company that installed the duct system.

3.7 Duct System manufacturer
Enter the name of the manufacturer of the duct system.

4 Enter Duct Network information for this test
Each standard requires different information to calculate results and compliance.

4.1 Duct Information for EN12237 and FD E-767

4.1.1 Class of duct network
The standard has a set number of classes that the designer will specify as a requirement for the ducts, and this impacts on how much sealing is required.

4.1.2 Temperature
Enter the temperature during the test.
4.1.3 Operating pressure in ducts
Enter the pressure in the ducts required by the standard during the test.
This value will be automatically chosen depending on what type of building is chosen. The user can override the default value.

4.2 Information for DW/143

4.2.1 DW/143 Duct Class
The standard has a set number of classes that the designer will specify as a requirement for the ducts, and this impacts on how much sealing is required. Selecting the Duct Class will set the default value for the operating pressure of the duct system, which is used as the target and reference pressure for the test.

4.2.2 Temperature
Enter the temperature during the test.

4.2.3 Operating pressure in ducts
Enter the pressure in the ducts required by the standard during the test. This is set to a default value when the Duct Class is selected but the designer can specify a different pressure and the tester can override this value.

4.3 Information for SMACNA
4.3.1 SMACNA Duct construction Class

SMACNA designed ducts are set to a Construction class which is based on the expected pressure to be experienced in the ducts during operation. Choosing this class will set the Specified test pressure to the construction class pressure. The designer is free to specify a different test pressure than this default.

4.3.2 SMACNA Duct sealing Class

The standard has a set number of sealing classes that the designer will specify as a requirement for the ducts, and this tells the installer how much sealing is required.

4.3.3 Temperature

Enter the temperature during the test.

4.3.4 Specified test pressure

Test pressure required to calculate the results at. This value will be set when the Duct Construction class is chosen but the user can change it.
4.4 Information for single point Residential test (North America)

4.4.1 Floor area
This entry text box will be available if the currently selected Standard requires the floor area to calculate final values.

Enter the floor area of the building in square feet.

This value will be used to calculate all results that requires floor area, such as CFM per square foot of floor area.

When changed, the Total Flow Allowed value in the Data Sets will change to reflect the new floor area.

4.4.2 Temperature
Enter the temperature during the test.

4.4.3 Operating pressure in ducts
Enter the pressure in the ducts required by the standard during the test. This will usually be either 25 Pa or 50 Pa, depending on the state building code.

5 Manage Pressurization/Depressurization (Data) Sets
The actual data read during an automatic test or entered for a manual test is stored in Data Sets based on the direction. Direction describes whether the test was performed to induce pressurization in the building or depressurization.
Data readings from each fan are specific to the range configuration installed on the fan when the pressure is read from the gauge. A Fan Pressure Line must be included in the set for each fan/range combination used during the test. New fan pressure lines must be added if ranges have to be changed during a test to reach the required induced pressure.

If fan pressure (or directly entered flow values) are too low to be in the valid calibrated region of the fan for the induced pressure point being measured, the digits will turn red at the row/column of the fan pressure line affected.

Pressurization/depressurization depends on the location of the red pressure pickup on the gauge with respect to the inside of the ducts, since duct induced pressure is measured between the red and blue connections, and the blue tube always goes into the ducts.

The location of the operator (red pickup on the gauge) as well as the sign (plus or minus) of the induced pressures are thus used to choose the label on the data set – “Pressurization Set” or “Depressurization Set”.
Data results can be added to the Set either manually or automatically.

Choosing “Capture data automatically” enables the Auto Test buttons, and grey's out all the data entry boxes in the Set (and will not let you type in them).

It also clears any data that was previously entered manually. If you do not want to clear the entered data, create a new Set to collect your automatic data.

To enter data manually that you have recorded on paper during a test, choose “Enter data manually”. This removes the Auto Test buttons, and changes the user interface to allow you to type into all the data entry boxes.

Each time you run another test after stopping for any reason, it is recommended that you add a new Set and delete the bad one, rather than restarting the test.
5.1 Adding a Set to the Test

You can add as many new sets as your needs require. To add a new set of data to an existing project, simply click the button.

All previously entered environmental data will be duplicated for this new set, but not the test results. This speeds the data entry required when starting a new Set, and helps if you have to run pressurization and depressurization tests (tests in both directions).

Add a set to include a test in the opposite direction.

5.2 Removing a Set from the Test

Delete any Set that should not be included in the average in the Summary Results (the section following all the Data sets).

You can add as many new sets as your needs require; if you decide that some of these sets are no longer necessary, click the button within that particular data set, and follow the prompt. This will be a permanent deletion, so be sure to save the Test file beforehand.

5.3 Clearing Data in the Set

Clicking the “Clear data set” will clear all result data that had been entered into that particular set, but leave the environmental data.

Clicking “Clear point...” will ask the user to specify which point to clear, giving a list of possible points. Once chosen, all readings taken for that particular column, from all fan/range combinations listed will be deleted.

To re-take data for a single point in a data set that was captured Automatically, you must use the “Begin Semi-Automatic Test” button as described in section 7.5.

5.4 View Graph of data in the Data set

Data in the set can be viewed on graphs – click on “Show Graphs”. The graph will open in its own window, and allow users the resize as necessary.
The number and location of the fan from which the readings are taken is shown on the graph legend, and moving the cursor over the points on the graph shows detail about each reading (pressure and flow at that point). The individual fan flow readings are shown, as is the sum of all flows in the case of the use of multiple fans.

If the “Show Graphs” button is clicked after an automatic test starts, the graph will be updated in real time as the readings are taken.

### 6 Enter Test Data

The following is an explanation of inputs in the Data Set.

Data may be changed in any one of the green or yellow boxes but you must click the button when any input changes are made, to re-calculate the new results.

If the data entry lines for pressures are greyed out and you wish to enter data using the keyboard instead of capturing it automatically from the gauge during a test, click on the “Enter data manually” choice. The software will ask if you want to lose any data entered.

If you have data entered in this data set that you wish to keep, start a new Data Set in which to capture your automatic data, and then in the NEW data set click on the “Enter data manually” choice.

Manually enter your data into all of the green or yellow boxes. Yellow boxes will turn green after entry.

Click the \[\text{Calculate}\] button once all the data is entered. Gray boxes below the manually entered data show the calculated results.
6.1 Start date

The date is entered automatically by the computer in the format yyyy-MM-dd when the test is created, but you can update at any time.

6.2 Start Time

24 hour time is automatically entered by the computer when you start a new test. If this time does not match the time you start your test, you can click to update the time that will be recorded in your report.

6.3 Operator location

The operator is assumed to be located outside the ducts during the test. This location is used in conjunction with the sign (positive or negative) from the Induced Pressure read from the gauge, to determine the test direction (Pressurization or Depressurization). The test direction will be displayed beside the Start time:

6.4 Duct Surface Area

Some standards require results to be calculated as flow divided by duct surface area. If the selected standard requires this, you will see data entry boxes to enter the duct surface area.

6.4.1 Duct Area Entry - EN12237 and FD E51-767

6.4.2 Duct Area Entry – DW/143
6.4.3 Duct Area and Leakage Factor Entry – SMACNA

<table>
<thead>
<tr>
<th>Square duct area</th>
<th>56.00 m²</th>
<th>Total Allowed Flow</th>
<th>85.88 L/s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Round duct area</td>
<td>67.0 sq ft</td>
<td>$C_L$ (rectangular)</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$C_L$ (round)</td>
<td>8</td>
</tr>
</tbody>
</table>

6.5 Pressure in the ducts data line

Enter the induced pressure, as read from the gauge (PrA on the gauge). This is the test pressure created in the ducts as a result of the door fan running.

You can adjust the [Time Avg] function of your gauge to ensure that proper averaging occurs during manual readings.

When manually entering data into FanTestic, set the time averaging on the gauge to at least 20 seconds for induced pressure and flow readings. This must be done in order to compensate for the effects of wind and to ensure that you get an average reading. On windy days you will have to take readings for a longer period of time. To determine if it is windy, set your gauge 25 second averaging and check if the pressure fluctuation is above 2 Pa. If so, double the time averaging for the induced pressure and flow readings to 40 seconds.

On the DM32, tap Channel A to activate the Hold feature so the readings don’t change while you’re writing them down.

6.6 Test Fan Data lines

Data readings from each fan are specific to the range configuration installed on the fan when the fan pressure is read from the gauge. A Fan Pressure Line must be added in the set for each fan/range combination used during the test. New lines must be added if ranges have to be changed during a test to reach the required induced pressure.

The fan number in the drop down next to “Test Fan” corresponds to the fan number in the list of fans you entered in the Equipment tab, see section 2.

If you are running a multiple fan test, Test Fan [1] is the fan attached to the primary gauge.

If you are running an automatic test, there will be no “New” button available, since fan pressure lines will be added automatically if a range change happens during the test.

6.6.1 Select Range installed on fan during test

The chosen range must match the range on the door fan being used for the test. The range must be selected correctly for FanTestic to calculate the correct flow.

It sometimes becomes necessary to change ranges during a test due to fan pressure too low. Fan pressure too low happens when there is not enough flow through the fan, so not enough fan pressure being generated across the fan pressure pickups inside the fan.
Range change is also required if FanTestic is unable to reach a pressure target so the fan speed gets up to 100% before the target pressure is reached.

These conditions can happen during a manual test, an automatic test, or a semi-automatic test.

*Setting the Range in use during an Automatic or Semi-Automatic test:*

FanTestic will read the Device and Range automatically from the connected gauge(s) during automatic/semi-automatic testing. This means you need to set the correct device and range on the gauge(s) when you set up the physical ranges on the fans. For details about range changing during automatic testing see section 7.6.

*To change the Range of the Fan Pressure line if you are entering data manually:*

Click the drop down labeled “Select Range” (or labeled with the name of the range currently selected) to open a selection dialog with pictures of all the possible ranges for this fan:

At the bottom of the Select Range chooser, you may also choose units for flow rates if you would like to manually enter flow rates by reading them directly off the gauge. If you only recorded flow values during a manual test, you will not have fan pressures to enter, so you must use this method.
6.6.2 Enter Fan Pressure value:
The units for the input values depends on the choice made in the Select Range chooser.
If you've selected a range plate, enter the fan pressure signal in Pa (PrB on the gauge).

If fan pressure (and thus flow value) is too low to be in the valid calibrated region of the fan, the digits will turn red. This would indicate the need for a range change to increase the fan pressure being used.

To delete a line of fan pressure input readings, click the button

6.6.3 Manual range change – how to add another fan pressure line

Add a new fan pressure line for the new range change by clicking the (“New”) button on the left of any of the existing fan pressure lines.

Enter the appropriate fan pressure data into the correct door fan pressure line, depending on the flow range used during the test. In the example below, the first target pressure was achieved with the 74 range plug; the second line would have a fan pressure value if the range plug in use had been 3.
6.6.4 When to change range during a test

It is recommended that the tester induce pressures over the full range of pressures desired to be tested (i.e., 10 and 60 Pa) prior to performing the test, to ensure that one flow range can satisfy all pressures, to avoid changing ranges, and to need only one fan pressure line in which to enter data.

If fan pressure (and thus flow values) are too low to be in the valid calibrated region of the fan for the induced pressure point being measured, the digits will turn red at the row/column of the fan pressure line affected. This indicates the need for a range change to increase the fan pressure being used. A rule of thumb to use for house testing fans is that fan pressure readings should be at least twice the required induced pressure.

a) If TOO LOW appears on the gauge:

- Increase fan pressure (restrict the flow) by installing a smaller flow range (for example, starting at C8, put in two more plugs for C6).
- Make sure this flow range change is recorded in your notes/test form.

b) If the fan is close to 100% fan speed without achieving the target pressure:

- Decrease fan pressure (increase the flow) by installing a larger flow range (for example, starting at C8, remove C range plate to end up with B ring).
- Make sure this flow range change is recorded in your notes/test form, and entered in the software.

6.7 Results for the Set

Each Test standard has specific requirements for calculating the results from the measured flow through the fan required to reach the induced pressure target. The results of these calculations are shown for each data set, and then for some standards, all sets are combined into a separate summary.

Click “Calculate” to force FanTestic to go through all the readings in the set and calculate the results, and then click on File>>Save.

Always click “Calculate” before creating a report, to be sure that the latest information has been included.

6.7.1 Allowed flow calculated before test commences

Some standards show the allowed flow at the specified reference pressure that must be achieved for the ducts to pass. If the selected standard has this, you will see it as a grey box.

6.7.1.1 Single point residential Total Allowed Flow
### 6.7.1.2 DW/143 Total Allowed Flow

<table>
<thead>
<tr>
<th>Duct Construction Class</th>
<th>Low-Pressure - Class A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature during test</td>
<td>20°C</td>
</tr>
<tr>
<td>Operating pressure of duct system, $P_{\text{ref}}$</td>
<td>500 Pa</td>
</tr>
<tr>
<td>Square duct area</td>
<td>56.00 m²</td>
</tr>
<tr>
<td>Total Allowed Flow</td>
<td>85.88 L/s</td>
</tr>
</tbody>
</table>

### 6.7.1.3 SMACNA Total Allowed Flow

| Square duct area | 56.0 sq ft |
| Round duct area  | 67.0 sq ft |
| $C_1$ (rectangular) | 16 |
| $C_1$ (round)    | 8 |
| Required $F$ (CFM/1000 sq ft) | 10.22 |
| $F$ (CFM/1000 sq ft) | 5.11 |
| Total Allowed Flow (CFM) | 5.723466 |
| 3.423817 |
| 9.147303 |

### 6.7.2 Duct leakage flow results for the Set

| Achieved Flow [m³/s] | 0.0003460 |
| Corrected flow rate [m³/s] | 0.0003437 |

### 6.7.2.1 Achieved Flow

Achieved Flow is calculated based on the type of fan and chosen range in use. The fan flow coefficients are used along with the fan pressure (and in some cases the pressure in the ducts), to calculate the flow. This is the duct leakage at the measured duct pressure.

### 6.7.2.2 Corrected Flow

Depends on the barometric pressure and temperatures during the test. This is the duct leakage at the measured duct pressure referenced to standard temperature and pressure.
6.7.3 Calculated results – EN12237

6.7.4 Calculated results – FD E51-767

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure in ducts [Pa]</td>
<td>77.9</td>
</tr>
<tr>
<td>Test Fan [Pa]</td>
<td>104.3</td>
</tr>
<tr>
<td>Achieved Flow [m³/s]</td>
<td>0.0003460</td>
</tr>
<tr>
<td>Corrected flow rate [m³/s]</td>
<td>0.0003437</td>
</tr>
</tbody>
</table>

**Duct Test Results**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f$</td>
<td>0.00008595 m³/s·m² at 77.9 Pa</td>
</tr>
<tr>
<td>$f_{max}$</td>
<td>0.0004660 m³/s·m² at 77.9 Pa</td>
</tr>
</tbody>
</table>

**Measurement result** - PASS

Parameters used for the set - Not Compliant

The ducts are measured to be in class: B
6.7.5 Calculated results DW/143

There are a number of results that are available based on the flows recorded in the data set.

6.7.6 Calculated results - SMACNA

There are a number of results that are available based on the flows recorded in the data set.
6.7.6.1  **Air flow at STP (at 50 Pa)**
This value shows the airflow in CFM calculated from the curve fit at 50 Pa and corrected to the Standard Temperature and Pressure (STP) of 20 C and 101.325 kPa. This air flow is used to calculate the other results for this data Set.

This value is sometimes referred to as CFM50.

6.7.6.2  **Air leakage coefficient (C_p) and pressure Exponent (n_p)**
A Building Leakage Curve (the ideal line) will be created after at least two points have been entered, which is used to estimate the leakage rate of the building at any pressure. The % value following the result is the error on the calculation of the C and n values - the 95% confidence range for the values which essentially means that 19 times out of 20 the results will statistically fall within this range.

This curve will be more accurate (line of best fit) after at least three points have been entered. The Building Leakage Curve is defined by the following equation:

\[ Q = C \times P^n \]

where:

- Q is airflow (in CFM)
- C is the Air Leakage Coefficient
- P is the pressure difference between the inside and outside of the building
- n is the slope of the building leakage curve

Example: calculate the airflow needed to create a 5 Pa pressure if:

\[ C = 110.2 \quad n = 0.702 \]

\[ Q, \text{ the airflow (at 5 Pa)} = 110.2 \times 50.702 = 341 \text{ CFM}. \]

It would take 341 CFM to cause a 5 Pa pressure change in this building.

6.7.6.3  **Flow / unit floor area (CFM50/sq ft)**
This is the flow (CFM50) result for this data set divided by the floor area of the building.

This normalized flow rate adjusts the leakage rate by the size (floor area) of the building. If you did not enter the floor area in the building dimensions section, this result will not be calculated.

6.7.6.4  **Flow / unit enclosure area (CFM50/sq ft)**
This is the measured flow (CFM50) result for this data set divided by the above grade building envelope surface area.

It is a useful method of adjusting (or normalizing) the leakage rate by the amount of envelope surface through which air leakage can occur.

Experience has shown that for buildings with a flow/surface area result of 1.0 or higher, very large cost-effective reductions in infiltration can often be achieved using door fan guided infiltration sealing and insulation techniques. In the 0.5 to 1.0 range, it is often more difficult to achieve economical improvements in airtightness.

If you did not enter an Above Grade Surface Area value in the building dimensions section, it will not be calculated.
6.7.6.5  **Equivalent Leakage Area (EqLA at 10 Pa)**
EqLA is defined as the area of a hole in a thin panel that would leak the same amount of air as the building does at a pressure of 10 Pa. The EqLA is used in the AIM infiltration model (used in the HOT2000 simulation program).

It most closely approximates physical hole sizes found in buildings - for example, a 1 inch by 36 inch crack under a door will measure about 36 square inches of EqLA.

6.7.6.6  **LBL Effective Leakage Area (ELA or EfLA at 4 Pa)**
This ELA was developed at the Lawrence Berkeley Laboratory (LBL) and is used in their infiltration model. The ELA is defined as the area of an elliptical nozzle-shaped hole that would leak the same amount of air as the building does at a pressure of 4 Pa.

ELA is at least 39% smaller than EqLA.

6.7.6.7  **LEED Permeability**
Effective leakage area at 4 Pa per 100 sq ft of area.
6.7.7 Calculated results - single point residential (North America)

Total Allowed Flow 0 CFM

Pressure in ducts [Pa]
Test Fan 1 Open Pa

Achieved Flow [CFM]
Corrected flow rate [CFM]

Duct Test Results
Result CFM/100 sq ft
Need Less than 0.0 CFM/100 sq ft

6.8 Data set notes

You can type notes with details about anything that may have happened during this specific data set capture in the data entry box labeled “(add notes here)”.

6.9 Finish time

When you’ve finished a pressurization or depressurization test, enter the finish time of the test manually or click Get Time.

7 Capture data with a Semi-Automatic Test

NOTE: The Semi-Automatic Test mode is still in its developmental “beta” phase and has not been thoroughly tested by Retrotec. Use at your own risk.

7.1 Before performing the semi-automatic test

Before performing an automatic test, ensure:
• The panels, flex ducts, fans and gauges are set up properly.
• Prior to the test, it is recommended to manually attempt to achieve the minimum and maximum pressures required for your automatic test, to ensure that your fan is on a test-suitable range.
• Ensure that your gauge is displaying the correct device and correct range configuration. Change settings to display the maximum and minimum flows. If TOO LOW appears, you must change to a lower range and try again since this will cause the test to pause (review quick guide for your system and see section 6.6.4). Make sure both the required duct pressures and flows can be achieved for the full range of pressures required for your test before starting Auto-Test.

For the automatic test with DM-2 gauge you'll need:

• A computer with a High Speed USB2.0 port
• A cable to connect the USB on your computer to the mini USB on your DM-2A
• A speed control Ethernet style cable to connect your DM-2 to a Retrotec fan
• The Retrotec DM2DeviceDriver for USB2.0 High Speed and FanTestic installed

For the automatic test with DM32 gauge you'll need:

• A computer with an Ethernet port or WiFi capability
• A cable to connect the Ethernet port on your computer with the “Network” port on your DM32
• A speed control Ethernet style cable to connect your DM32 “Control” port to a Retrotec fan
• DM32 with Network set to either WiFi Create mode or Wired/Static mode
• If WiFi Create mode is used, PC must successfully join the DM32 WiFi hotspot before starting the auto test
• FanTestic installed

Start the software program, create a new test, and ensure the test standard is being used is the duct test you want (see section 1.6).

The Settings should be reviewed because this will dictate how the automatic test is to be performed, see section 1.9. The default settings can be changed before any test.

7.2 Connect your Gauge to the Computer

7.2.1 DM-2 (use USB connection)

Connect your DM-2 to the computer with the supplied USB to mini USB cable.

Note: The mini USB on the DM-2 is the control connection for automatic testing and is connected to the USB on the laptop or hub. The yellow Ethernet style connector is the Fan Speed Control Cable and is NOT used to connect the gauge with a computer or network, it simply goes between the DM-2 and the fan so the gauge can control the fan speed.

Note: If you have more gauges than the number of USB ports on your computer, you can purchase an actively powered USB HUB from an electronics store, which allows multiple USB inputs.

Also, any DM-2 gauge that is older than Firmware Version 3.0 requires an Active Powered USB2.0 High Speed HUB. In other words, DM-2 gauges with Firmware versions 3.0 and later may not require actively powered USB HUBs – The firmware version is displayed when you turn on the DM-2 gauge, and on the top line when you push [Setup].
7.2.2 DM32 with WiFi connection

Turn your DM32 gauge on.

Check that the selected device matches the fan you are going to use for the test, and the correct range is chosen on the gauge to match what is installed on your fan.

From the home screen, tap “Settings”, then tap the “… ” key. Check that the setting key labeled “Network” reads “WiFi Create” in white text. If not, tap it and then tap “Status” until it reads “WiFi Create” then go back to the home screen. The DM32 gauge will create a WiFi hotspot that your computer can connect to.

Connect your computer to the WiFi hotspot created by the DM32 gauge (when it is set with “Network” = “WiFi Create”) using your normal Wireless connection panel - same procedure you would use to connect to the wireless hotspot at the coffee shop.

Depending on your version of Windows, it will look something like:

See the connect computer section of the DM32 WiFi QuickGuide for more information.

7.2.3 DM32 with Wired Ethernet connection

Turn your DM32 gauge on.

Check that the selected device matches the fan you are going to use for the test, and the correct range is chosen on the gauge to match what is installed on your fan.

From the home screen, tap “Settings”, then tap the “… ” key. Check that the setting key labeled “Network” reads “Wired” in white text. If not, tap it and then tap “Status” until it reads “Wired”, then tap “Mode” until it reads “Static”, then go back to the home screen.

Connect the blue Ethernet cable from the DM32 “Network” connection on the bottom of the gauge to the Ethernet connector on your computer.

The yellow Ethernet style connector is the Fan Speed Control Cable and is NOT used to connect the gauge with a computer or network, it simply goes between the DM32 port marked “Control” and the fan so the gauge can control the fan speed.

See the DM32 QuickGuide for more information.
7.3 Find connected gauges to use for the test

Look at your gauge(s) and check that the selected device matches the fan you are going to use for the test, and the correct range is chosen on the gauge to match what is installed on your fan, since that will be read in by the software.

![Find Gauges](image)

Click the button. The FanTestic software will find the gauges and fill in serial number automatically. The model of the fan will also be changed to whatever device is set on the gauge, but the serial number of the fan must be entered manually.

The Range Configuration displayed on the gauge will be read in and used to create the fan pressure lines in the data set.

If the range configuration is incorrect it can be changed in the software at any time after the test is complete.

7.4 Understanding the Semi-Automatic Test Mode

The Semi-Automatic Test feature allows you to capture data into the data set on the computer, with automatic control of the gauge.

This feature provides a way to take test points under user-defined conditions, and at intervals of time that are also user-defined. It is as if a manual test was being completed, but instead of physically writing down the results from the gauge screen, the software program will record values more accurately and calculate results, like it does during an automatic test.

This feature will also allow a tester to repeat a test point that may have gone awry for whatever reason during an automatic test, by selecting the appropriate input cell point and re-taking that data point.

7.5 How to use the Semi-Automatic Test feature

![Begin Semi-Automatic Test](image)

If the “Begin Semi-Automatic Test” button is not visible, click on the “Capture data automatically” choice. The software will ask if you want to lose any data entered.

If you have data entered in this data set that you wish to keep, start a new Data Set in which to capture your automatic data, and then in the NEW data set click on the “Capture data automatically” choice.
Click [Begin Semi-Automatic Test]. Click [OK] to accept the warning message “The Semi-Automatic Test mode is still in its developmental “beta” phase and has not been thoroughly tested by Retrotec. Use at your own risk.”

FanTestic will search for attached gauges and make sure they are sending and receiving data. The Test Dashboard that you use in Automatic Testing is used in Semi-Auto as well to provide you information about the state of the test and gauges. Once gauges are found, the information will display in the Test Dashboard:

A small window called “Semi-Automatic Testing” will then pop up that will act as the control window for the semi-automatic data collection option.

You will control either “All gauges” or a single gauge by serial number, by choosing the appropriate item in the first dropdown.
Fans can be controlled to reach a target pressure either by setting the speed, or by setting the target building pressure. Enter the target fan speed or building pressure into the appropriate green box, or use the slider to increase/decrease the speed and/or pressure. Click to start the fans at the speed/pressure selected, or to update them if the speed or pressure value has been changed.

Determine what type of point is to be taken (bias pressure initial or final, or building pressure). This point can be put into the next empty or incomplete cell in FanTestic. You can choose also which of the 12 cells to put it in by selecting the appropriate choice in the drop-down box:

If taking bias pressures:

choose Initial baseline or Final bias pressure, set the fan speed to zero or set the pressure target to 0 and click , and then click .

If you are going to collect data, do not click Stop Fan(s) to set the fan speed to zero, because that tells the Test Dashboard in FanTestic that the Semi-Auto window is not doing any more data collecting.

Once the Test Dashboard says that the building pressure has been achieved, or you are satisfied with the fan speed you can collect induced pressures. Click the button to have the target data point captured in the software program. If pressure has not been attained in the Test Dashboard, you will get a message telling you to wait.

Back in the Data Set, data may be changed in any one of the grey or green boxes but you must click the button when any input changes are made including by the capture of a new target point, to re-calculate the new results.

The Finish time will be filled in automatically at the end of the test on auto test mode, unlike manual mode where it must be entered manually.

7.6 Changing the Range during a semi-automatic test

The same conditions may arise during an automatic test as in a manual test, for which the fan Range must be changed, see section 6.6.4.

If these conditions occur during the test, FanTestic will automatically pause the test and request the tester to change ranges.

If the induced pressure target cannot be reached but the fan is at 100%, the following window will open asking you how to proceed:
If fan pressures become too low, %, the following window will open asking you how to proceed:

If you determine that you need to change the Range to complete the target point, click on “Pause test and change range”, then physically change the range on the fan, and change the Range showing on the gauge. You will see the following in the Test Dashboard.

Use the dropdown box, highlighted in the image above, to select the new range.
If you are close to your gauge, you will see the new range is set on the gauge, and the new range shows up in the Test Dashboard.

A new Fan Pressure line will be added to match the new range:

If there was data already in the fan pressure line for the first range, then you will see two fan pressure lines for the same fan:

Click [Continue] to continue the test on the new range.

If fan pressure (or flow value) is too low to be in the valid calibrated region of the fan for the induced pressure point being measured, the digits will turn red at the row/column of the fan pressure line affected.

This is an indication that the point will have to be re-taken (use semi-automatic mode or start a new data set and start the whole test over).

### 7.7 View the Gauge Display during a semi-automatic Test

FanTestic provides a Gauge Display while you run a test, which allow you to see your test in action. You can show or hide the gauge display by clicking on the arrow labeled either “Hide Gauge Display” or “Show Gauge Display” in the upper right hand corner of the FanTestic window.

For the duration of your test, virtual meters and gauges visually display the progression of the building’s pressure, the building’s pressure change rate, the fan’s air flow rate, and the fan’s speed.
8 Summary Test Results

Some of the standards show a summary of the results in a separate tab, some show the compliance for each set only. The “Results Summary” section includes the summarized results from all the data sets in the Test file.

Click on any data set if any data has been changed in order to calculate and view the current results.

8.1 Compliance – was test performed according to Standard?

The Compliance Statement lists the test conditions and resulting measures that must be taken and achieved respectively, during a building air leakage test in order for the test to comply with the duct testing standard in use. It must be looked at after every air leakage test is complete.

8.1.1 Compliance – EN12237 and FD E51-767

Based on the selected Building Type, the operating pressure of the duct system is set. This becomes the reference pressure for the test. The results show the Achieved Flow and Corrected Flow at whatever pressure the test is carried out at. The Duct Test Results show the flow per square metre, f, that was achieved at the required test pressure (n = 0.65 for ducts). That f is compared to the maximum allowed flow per square metre to determine a measurement result PASS.

Compliance is determined by the Length of Junctions Tested (if the building is not Residential), and the Surface area of the ductwork tested. The test must also have been carried out for the minimum time...
specified (usually 5 minutes or 300 s), and the pressure over the duration of the test must stay within +/-5% of the target.

As an informational item, the Class achieved by the ducts is also included. They may be tighter (PASS) or looser (FAIL) than was specified.

<table>
<thead>
<tr>
<th>Class of duct network</th>
<th>A</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Temperature during test</th>
<th>20 °C</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Operating pressure of duct system, P&lt;sub&gt;ref&lt;/sub&gt;</th>
<th>80 Pa</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Achieved Flow (m³/h)</th>
<th>0.0003460</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corrected Flow rate (m³/h)</td>
<td>0.0003437</td>
</tr>
</tbody>
</table>

8.1.2 Compliance DW/143

<table>
<thead>
<tr>
<th>Duct Construction Class</th>
<th>Low-Pressure · Class A</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Temperature during test</th>
<th>20 °C</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Operating pressure of duct system, P&lt;sub&gt;ref&lt;/sub&gt;</th>
<th>500 Pa</th>
</tr>
</thead>
</table>

Based on the selected Duct Construction Class, the operating pressure of the duct system is set. This becomes the reference pressure for the test.
The results show the Achieved Flow and Corrected Flow at whatever pressure the test is carried out at. A visual check can be made, comparing the Total Allowed Flow with the resulting Corrected Flow to see if the test has passed.

The Duct Test Results show the flow per square metre, f, that was achieved at the required test pressure (n = 0.65 for ducts). That f is compared to the maximum allowed flow per square metre to determine a measurement result PASS.

Compliance is determined by checking that the test was carried out for the minimum time specified (up to 15 minutes or 900 s), and the pressure over the duration of the test must stay within +/-10% of the target.

8.1.3 Compliance – SMACNA

Based on the selected Duct Construction Class, the Specified Test Pressure is set. This can be changed by the user, but whatever this number is becomes the reference pressure for the test.
SMACNA provides a Leakage Factor $C_L$ for each shape of duct which is used to calculate the maximum flow per area, $F$. The $F$ for each shape of duct are then used to calculate the allowed flow for each shape, and the Total Allowed Flow is shown.

Once the Achieved and Corrected Flow are determined by the test, that value is referenced to the specified test pressure, the achieved Leakage Class is calculated, and the total flow per area is compared to the required to determine the Measurement result PASS or FAIL.

### 8.1.4 Compliance – single point residential (North America)
8.2 Summary Results – average of test data sets

If both depressurization and pressurization test sets are completed, the results will be provided as an average of all the data set results. The average of the results from each test set are used to create the entries in the summary table.

The reason behind performing an air leakage test in both directions is to average out any potential pressure problems there might be in one direction over the other (like blowing open a damper in one direction, but sucking it closed in the other).

8.2.1 Single point residential Summary Results

8.2.2 DW/143 Summary Results
8.2.3 SMACNA Summary Results

FanTestic provides a graphical display of the test data collected, opened by clicking the button in the Summary Results section below the combined Mean or Reduction calculated test results.

The graphs will open in a new window that can be opened and closed at any time. Two graphs will be displayed.

The graph on the left shows the pressure readings (Pa) from the gauges. The graph on the right shows the total fan flow rate (CFM or other flow units) plotted against building pressure on a logarithmic scale. The right hand graph also shows the ideal (regression) line based on the data points, and the individual flow rates from all the fans that are included in the total.
9 Cost of Duct Leakage calculator

The Cost of Duct Leakage Calculator uses the duct leakage measurement results from the test data sets to estimate the cost of the duct leakage.

If you click “OK to close the window, values from the calculator will show up in the report generated when you click “Generate Report” from the file menu. The values entered are not saved in the test file, so you have to re-enter them if you close and re-open FanTestic.

Click “Cancel” to close the window without saving your entered information. The “X” button to close is disabled.

Fill in all the data in the green boxes with information and you will see the values for efficiency and cost in the bottom section change.

*The "Annual Cooling Cost" and "Annual Heating Cost" in the report are for estimation purposes only*
9.1 Percent Duct Leakage to Outdoors
Enter the estimated percentage of the Total Duct leakage that leads to outdoors in order to estimate Cost of Duct Leakage. 0% means that none of the duct leakage goes to the outdoors, and 100% means that all of the duct leakage measured is going to the outdoors.

9.2 Air Handler Flow
Enter a flow in CFM that must be greater than the measured duct leakage flow.

9.3 Annual Cost of Heating
Enter heating cost per year from the utility bill. This entry is used to estimate the cost of Duct Leakage to Outdoors included in the heating bill.

9.4 Annual Cost of Cooling
Enter the cooling cost per year from the utility bill. This entry is used to estimate the cost of Duct Leakage to Outdoors included in the cooling bill.

9.5 Rated SEER for cooling equipment
Enter the Seasonal Energy Efficiency Rating (SEER) for the cooling system, typically 7 to 10 for new systems.

9.6 Leakage Split (Supply and Return)
Enter the estimated fraction of the Total Duct Leakage that is on the supply side and the return side. Their default values are 0.5, meaning the leakage of the HVAC system is split evenly between the supply and return. The Leakage Split for the supply side and the return side always add up to 1.0.

9.7 Supply Leakage Penalty
This is the estimated fraction of energy loss of the supply side. The default value is 1.0. This means that of the supply air leakage, all of its energy is lost to the outdoors (i.e., none of its energy is returned back into the house). This number can be lowered if some of the energy from duct leakage leads back into the house.

For example, if supply leaks are going into a wall cavity, some of the energy loss will be regained back into the house, so a lower leakage penalty would provide a better estimate of annual HVAC losses.

9.8 Return Leakage Penalty
This is the estimated fraction of energy loss of the return side. The default value is 0.5, which assumes that of the return air leakage, about half of its energy is lost to outdoors (i.e., the other half of its energy is regained back into the house). This number can be raised if you suspect that there is actually more energy loss to the outdoors from the return side.

For example, if the return goes through a very cold crawl space, the return leakage would pull in cold air and have a greater effect on the annual HVAC losses.

9.9 HVAC System Efficiency Loss
Will be calculated based on the inputs.
9.10 Cost of Heating the Leakage
Will be calculated based on the inputs.

9.11 Cost of Cooling the Leakage
Will be calculated based on the inputs.

9.12 Annual Operating SEER
Will be calculated based on the inputs.

10 Use the Test results

10.1 Open an existing Test file
To open a test file that has already been completed and saved, there are several options:

- The main opening screen for FanTestic displays can display previously completed tests in the “Test History” pane on the left hand side (with a photo of the building, if it was included when the test file was created). If you have this option turned on (“Test History” → “AutoHide” not enabled), the list will remain open on the left at all times. Click the name of the test file you would like to open.
- Click on “File” → “Open” and a pop-up Windows Explorer window will display all tests in the [MyDocuments]\Retrotec\Tests directory which have the file extension “.exml”.
- Click on “Test History” → “Show” – the left hand list of all saved tests will appear, the same as the one displayed on the opening screen for FanTestic.

If you open an existing test with AutoSave turned on, and make changes, your original file will be changed and saved in the changed state and will not be recoverable. It is always best to work on a copy of an older test so that the original data is always available.

10.2 Save results to a test file (.exml)
When a new test file is created, it is automatically named based on the Standard used and the date (yyyy-MM-dd) and time (HHmm) that the file was created, and it has a file extension of .exml.

For example, “FDE51 2014-02-28 1642.exml” would be the name of the file using the FD E51-767 standard created at 16:42 (4:42pm) on the 28th day of February in the year 2014.

When you click “File” → “Save”, FanTestic stores test data into that file.

Test files are normally saved on your local C: drive under [MyDocuments]\Retrotec\Tests.

Test data can be automatically saved at periodic intervals by turning the Auto Save function on (“File” → “Auto save?”).

Turn AutoSave Off if you wish to double click to launch test files attached to emails.

10.3 Save As to save results to a different file
FanTestic can store test data (“File” → “Save As”), which creates a new test file with the same name as the current test file but with the current date (yyyy-mm-dd) and time (HHMM) added at the end. The new file is normally saved in your MyDocuments\Retrotec\Tests folder.
For example, using the original test file “FDE51 2014-02-28 1642.fxml”, if we do a “File” \( \rightarrow \) “Save As” at 10:42am on the 3rd of March 2014, the new file will have the suggested file name: “FDE51 2014-02-28 1642 [2014-03-03 1042].fxml”.

The “SaveAs” function makes it convenient to save the original test and keep it intact, but have a second “Save As” copy in which to manipulate parameters without affecting the original test.

The “SaveAs” copy of the file may be changed without affecting the original test data, but the two files are visually linked via the filename.

10.4 Print the Test as a Print-Screen

FanTestic will print the data as-is, i.e. only what is on the interface screen.

Click on “File” \( \rightarrow \) “Print”, and you can either generate a PDF document or print a paper copy using the printer functions in Windows.

The “Print” function essentially prints a screen shot of the FanTestic interface with each of the expander sections open, even if you cannot see all of the expander information on the screen at once.

Alternatively, and more effectively, you can generate a report from the data and print the report, see section 11.

11 Create a report from the Test results in MS Word

FanTestic includes a built-in template to generate reports for test results, each template specific to a test standard (such as SMACNA, FDE51, DW143, EN12237 or RESDUCT). Users can customize the templates, and can have several different templates for each standard if they wish. Before generating a report, FanTestic will ask the user to choose the template from which to generate the report.

The report generation function is only available if you have a valid, non-expired license for FanTestic. If you do not have such a license, you will be limited to seeing results on the screen.

11.1 Generate Report

To generate a report, click on “File” \( \rightarrow \) “Generate Report (docx file – MS Word)”.

FanTestic will ask you to choose the template to use for the report, and then generate and automatically open a Word document containing the data and results from your test. The generated report will be saved in your [MyDocuments]\Retrotec\Reports folder with the name you choose.
Once the Word document is open, you can edit and print it directly, or create a PDF using the functions of MS Word.

11.2 View listing of reports

Click on “File” → “View Reports in directory”.

Windows File Explorer will open on your [MyDocuments]\Retrotec\Reports directory. You can then open any of the report (.docx) files that appear.

11.3 Customize the way your Report looks

Because the report is created by copying a template document and replacing tags with the actual test data, reports are customizable in Microsoft Word with FanTestic.
Duct test reports in English are generated using a template based on the name of the duct test standard, and which will be located in the [MyDocuments]\Retrotec\Templates directory after you have created at least one report.

If you are using SMACNA, english language, the template will be called “SMACNA-en.docx”.
If you are using EN12237, english language, the template will be called “EN12237EU-en.docx”.
If you are using FD E51-767, english language, the template will be called “FDE51-en.docx”.
If you are using DW/143, english language, the template will be called “DW143-en.docx”.
If you are using single point residential testing, the template will be called “RESDUCT-en.docx”.

To generate a report, FanTestic creates a copy of the template with the report name chosen and goes through the template, replacing any of the words surrounded by {} with specific test results or words. Those words surrounded by {} are known as “tags”.

Users customize the report output by changing the text in the template file that is used to create the Word document, and as long as the tags remain somewhere in the template, test data will be output to the generated document, replacing those tags.

If you want to create a language specific report, to match the language you use in the user interface, you can translate the template and change the two letter language identifier in the name. For example for FD E51-767 you would call it “FDE51-fr.docx” where the english language “en” has been replaced with the french language identifier “fr”.

Some templates may already be provided in translation, and if so, they will automatically be chosen for you if you have changed the language to use in FanTestic.

To start customizing a template, click on “File” → “Customize Report Template”.

Windows Explorer will open on the [MyDocuments]\Retrotec\Templates directory so you can choose a template to edit. FanTestic will then copy the chosen template to a new document called “xxxxxx_To_Customize [yyyyMMdd-MM-dd hhmm].docx” and open that for you to edit.

The report generation and template editing functions are only available if you have a valid, non-expired license for FanTestic Integrity. If you do not have such a license, you will be limited to seeing results on the screen.
For full details on customizing your report, and a reference of all the available tags, see the separate manual:

Manual-FanTestic-How to Customize Generated Reports.pdf

### 12 Export Data to MS Excel

FanTestic includes a template for raw data to be exported to Microsoft Excel, in order to view all readings that went into each averaged test point.

To export data, click “File” → “Export Data (Excel)” . This process takes a few minutes, especially for large files, so allow it to process even if it appears to be frozen.

Once completed, an Excel spreadsheet document will open containing all data readings taken during the test. These will be stored in the same location as the reports ([MyDocuments]\Retrotec\Reports), but will have the file extension .xlsx.

For details on customizing your output to Excel, and a reference of all the available tags, see the separate manual:

Manual-FanTestic-How to Customize Generated Reports.pdf

### 13 Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Solution</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cannot generate reports in FanTestic</td>
<td>• Make sure you are using the most recent version of Microsoft Word (2007 or greater)</td>
</tr>
<tr>
<td></td>
<td>• If you are using an earlier version (2003 or earlier), please download a free compatibility pack <a href="#">here</a> that will allow you to open/edit/save Word 2007 documents.</td>
</tr>
<tr>
<td></td>
<td>• If this does not fix the problem, contact us.</td>
</tr>
<tr>
<td>Cannot find gauges with DM-2 connected – DM-2-to-computer connection is not functional</td>
<td>• You must download the DM-2 USB driver from Retrotec’s website in order to get the computer to recognize the DM2 gauge. You can access this driver <a href="#">here</a>.</td>
</tr>
<tr>
<td></td>
<td>• Make sure to first right click “DM2deviceinstaller” exe and select Run as administrator to install it, instead of double-clicking the file.</td>
</tr>
<tr>
<td></td>
<td>• If the driver is downloaded and functional, unplug the DM-2 from the computer, power it off, turn it back on after 10 seconds, and re-plug it back in.</td>
</tr>
<tr>
<td></td>
<td>• Try the button once more.</td>
</tr>
<tr>
<td></td>
<td>• Try plugging the DM-2 into an active powered USB hub (with hub plugged into mains power)</td>
</tr>
<tr>
<td>Cannot find gauges using DM-2 with firmware older than version 3.0 (The version is displayed when you turn on the DM-2 gauge, and on the top line when you push [Setup].)</td>
<td>• Any DM-2 gauge that is older than Firmware Version 3.0 requires an Active Powered USB HUB, with hub plugged into mains power.</td>
</tr>
<tr>
<td>Find Gauges with DM-2 gauges results in a message containing the phrase “Error 5: Access Denied”</td>
<td>• You must run FanTestic as Administrator</td>
</tr>
<tr>
<td></td>
<td>• See the document: <a href="#">Solve DM-2 Access Denied Errors</a></td>
</tr>
<tr>
<td>Intermittent DM-2 connection over USB</td>
<td>• Try plugging the DM-2 into an active powered USB hub (with hub plugged into mains power)</td>
</tr>
<tr>
<td></td>
<td>• Try running both the laptop and the DM-2 from batteries, not plugged into any external power source</td>
</tr>
</tbody>
</table>
If after doing an update or install, you get the following notification:

![Application cannot be started. Contact the application vendor. Click here to send this error to the deployment server and check for known solutions to this problem.
](image)

This means that you had a previous version of FanTestic that was set up to “Run as Administrator”, likely to allow connection to the DM-2 gauges for automatic control over the USB port.

<table>
<thead>
<tr>
<th>Try a new USB cable</th>
</tr>
</thead>
</table>

- Click ok on the error, delete the old ADMIN shortcut and
- create a new shortcut as described in the Solve DM-2 Access Denied Errors if you need to control DM-2 gauges
- use the newly created shortcut if you are not using DM-2 gauges

Unable to find gauges with DM32 connected to USB port of laptop

- Try plugging the DM32 into an active powered USB hub (with hub plugged into mains power). Some new laptops do not provide enough power on the USB port.
- Use the Ethernet port on the DM32 for automatic control instead of the USB

If you experience a problem that you cannot fix by troubleshooting, make sure you have the latest version of FanTestic software installed, and that your Microsoft Windows has all the service packs and updates installed (including .NET 4).

To install the latest automatically, connect to the internet and restart FanTestic – if there has been an update since your current version, you will be prompted to download the latest updates.

However, if you have been using FanTestic running in Administrator mode, the “Check for Updates” may not work correctly. To be sure you have the latest, you should go to the Retrotec website: [http://retrotec.com/support/software-downloads](http://retrotec.com/support/software-downloads)
Then click on the Download button beside FanTestic. That will open a webpage which will show that latest version. If this version is different than what you have installed, you should use Control Panel to uninstall FanTestic from your computer and proceed to install the new version as described in section 1.3.

14 Contact Tech Support

If you are still having problems even after updating to the latest software version and updating your Windows with all patches, follow these steps:

For Technical Support or to send suggestions, create an email to support@retrotec.com

If you have encountered a bug which makes FanTestic crash, create an email to: bugs@retrotec.com

In your email, describe the problem and when it occurs, and attach the following:

- The standard are you using (click “Settings” → “Change Standard” to check)
- Log file from [My Documents]\Retrotec\Logs
- Test file you are using, file extension .xml
- Settings.xml file [My Documents]\Retrotec\AppData
- A screenshot of the software running or having the error
- the version of Microsoft Office you are using
- The version of Microsoft Windows you are using
14.1 The log file

Each test has an associated log file that is saved on your C: drive, in the Retrotec folder. These logs will help Retrotec to determine where the problem occurred. You can access the log files in your local drive, in [My Documents]\Retrotec\Logs.

A new log file is created for each day, named Log_yyyy-MM-dd.txt. If you leave FanTestic running over the course of multiple days, the log file will have the date of the day when FanTestic was initially started. The correct log file to send will be named with the date you began the test (even if changes were made over several days).

14.2 The .exml test file

Test files with extension .exml can be found in the My Documents\Retrotec\Tests folder, and are saved in the same fashion as log files. The name of the .exml file is the date you began the test. Send the .exml file with the same name/date as the log file.

14.3 Settings file

The Settings.xml file is found in your [My Documents]\Retrotec\AppData folder, and contains information troubleshooting personnel can use to diagnose the problem.

14.4 A screenshot

Screenshots are a way to show our tech support staff what your error looks like on your screen. This will help us, along with the background information (log and .exml files), to determine the best approach to fix the problem.

Current versions of Microsoft Windows include the “Snipping Tool” which can be used to make a screen snip of the window or of an area of a window on the screen. The image will be on the Windows clipboard as if it has been “copied” so you can just “paste” it into an email.

In older versions you may need to create a document and then capture an image of the screen you are currently looking at, by pressing the [Print Scrn] button on your keyboard. In order to attach this image as a file for us to view, you must paste it into a document.
To do this, in the open Microsoft Word or Paint document, right click on your mouse and select Paste (or Edit → Paste). The captured image of your screen should appear in the document. You can now save this document and include it as an attachment when you submit your information to us.